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1. General 
1.1. How does the Backup Deposit Box software work? 

The Online Backup Suite consists of 3 main modules: 
 

1. Client software – Online Backup Manager (OBM) or A-Click Backup Client (ACB) 

2. Server software –Backup Deposit Box (BDB) 

3. Optionally, a replication server – Replication Server (RPS) 

 
OBM is a sophisticated client application that is targeted for technically savvy end-users and 
for network administrators. It has a user-interface for easy yet robust backup configuration. 
It allows users to upload selected files to the Backup server and runs scheduled backup jobs. 
It also allows users to create different backup sets for different backup purposes. Besides file 
backup, OBM can back up a number of application databases, such as those for MS Exchange, 
MS SQL, Oracle, MySQL, Lotus Domino, and others. OBM supports Windows 2000, XP, 2003, 
Linux, Mac OS X, Novell NetWare, and Sun Solaris. 
 
ACB is a ‘lite’ client application with basic file backup functionality and an intuitive 
user-interface. It is targeted for end-users (vs. network administrators). It allows users to 
upload selected files to the Backup server and runs scheduled backup jobs.  
 
BDB is a server application that receives and stores backup data from OBM and ACB clients. 
It is usually located at a backup service provider location. It has a web-based Management 
Console that enables users to manage their own backup account or restore their own backup 
data. BDB supports Windows, Linux and Mac OS platforms. 
 
RPS is another server application running on two paired backup servers at two different 
backup service locations. It provides redundancy for the service’s BDB servers. If one of the 
BDB servers fails, the other still has a copy of all client backups.   
 
The relationships are depicted in the diagram below. 
 

 
 
^Back to top
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1.2. What is the recommended bandwidth? 

It really depends on the kind of data to be backed up, e.g. for personal file backups, the daily 
data transfer is usually very limited, while MS Exchange backup could be significant. You may 
want to use the following white paper as a reference: 
 
 http://MyBox.BackupDepositBox.com/obs/download/BDB-Backup-Speed.pdf. 
 
^Back to top

1.3. How do I run Online Backup Manager with Microsoft ISA 2004? 

To connect OBM to BDB through Microsoft ISA Server, please do the following to enable the 
[Web Proxy] service on the ISA Server: 

1. Open [Start] -> [Programs] -> [Microsoft ISA Server] -> [ISA Server Management] 

2. On the left panel, select [Microsoft Internet Security and Acceleration Server] -> 
[SERVER] -> [Configuration] -> [Networks] 

3. On the top menu, select [Action] -> [New] -> [Network]. Enter a “Network Name” 
(e.g. Internal) and define the IP address range for your internal network  
(e.g. 192.168.1.0 - 192.168.1.255) 

4. Double click the new network that should now be added to on the bottom panel 

5. Select the [Web Proxy] tab  

6. Check both [Enable Web Proxy clients] and [Enable HTTP] checkboxes and choose a 
[HTTP port] for the web proxy service 

7. (Optional) Press the [Authentication] button, check the [Basic] checkbox and the 
[Require all users to authenticate] checkboxes if you want to enable and enforce 
proxy authentication 

8. Press the [OK] button to make the changes and press the [Apply] button to apply the 
changes 

9. Open [Online Backup Manager] from the system tray and press the [Options] button 

10. In the [Proxy Setting] section, select the [Proxy] radio button 

11. Enter the hostname/IP address of the ISA server in the [Proxy Address] text field and 
the TCP port for web proxy service on your ISA Server in the [Port] text field 

12. Press the [OK] button to connect to the server  
 
If you run into any problems connecting to the BDB from OBM using ISA Server, please do the 
following to check if your request is being blocked: 

1. On the left panel of [ISA Server Management], select [Microsoft Internet Security 
and Acceleration Server] -> [SERVER] -> [Monitoring]  

2. Then select the [Logging] tab that appears on the right panel. Click the [Edit Filter] 
link and create a filter with the following values: 

 [Log Record Type] equals [Web Proxy Filter] 

 [Destination IP] equals [The IP address of Offsite Backup Server] 

3. Press the [Start Query] button 

4. Open [Online Backup Manager] again and try connecting to the BDB using the same 
procedure above.  

 
Check if there are any errors generated in the log table. 
 
^Back to top

1.4. How do I install OBM on FreeBSD? 

You can either run OBM on a Linux version of Sun Java JDK (performance might not be 
optimized) or on a FreeBSD native Java SDK. 
 

 

http://mybox.backupdepositbox.com/obs/download/BDB-Backup-Speed.pdf


 committed to your peace of mind 
Backup Deposit Box

 Technical FAQ
 

The InfoTech Group Page 6 of 29 9-30-2007

Please do the following for the Linux version of Sun Java JDK option: 

1. Install Linux binary compatible port to the FreeBSD machine 

2. Install the Linux version of Sun Java 1.4.2 or above JDK onto the FreeBSD machine 

3. Create a symbolic link from $OBM_HOME/jvm to $JAVA_HOME (installed in previous 
step) 

4. Run $OBM_HOME/bin/RunBackupSet.sh [BACKUP_SET_NAME] to run your backup 

5. Run $OBM_HOME/bin/Scheduler.sh to start the backup scheduler 

 
Please do the following for the FreeBSD native Java SDK option: 

1. Install Linux binary compatible port to the FreeBSD machine 

2. Install the Linux version of Sun Java 1.4.2 or above JDK onto the FreeBSD machine 

3. Compile the FreeBSD native Java 1.4.2 SDK using the JDK compiler installed in the 
previous step 

4. Install the FreeBSD native Java 1.4.2 SDK onto the FreeBSD machine 

5. Create a symbolic link from $OBM_HOME/jvm to $JAVA_HOME (installed in previous 
step) 

6. Run $OBM_HOME/bin/RunBackupSet.sh [BACKUP_SET_NAME] to run your backup 

7. Run $OBM_HOME/bin/Scheduler.sh to start the backup scheduler  

 
^Back to top

1.5. How do I install OBM on SCO Unix? 

Please do the following to install OBM on SCO: 

1. Install Java 1.4.x or above onto your SCO Unix box 

2. Download obm-linux.tar.gz and expand it to $OBM_HOME (e.g. /usr/local/obm) 

3. Delete $OBM_HOME/jvm and create a symbolic link from $OBM_HOME/jvm to the 
SCO Unix Java VM 

4. Run $OBM_HOME/bin/BackupManager.sh to set up your backup set (or run 
$OBM_HOME/bin/Configurator.sh if you are in command line mode. Then use the 
OBM Management Console to set up your backup sources and other settings) 

5. Run $OBM_HOME/bin/RunBackupSet.sh [BACKUP_SET_NAME] to run your backup 

6. Run $OBM_HOME/bin/Scheduler.sh to start the backup scheduler 

 
^Back to top

1.6. How do I install OBM on AIX? 

Please do the following to install OBM on AIX: 

1. Install Java 1.3.x or above (Java 1.4.2 or above recommended) onto your AIX box 

2. Download obm-linux.tar.gz and expand it to $OBM_HOME (e.g. /usr/local/obm) 

3. Delete $OBM_HOME/jvm and create a symbolic link from $OBM_HOME/jvm to the 
AIX Java VM 

4. Run $OBM_HOME/bin/BackupManager.sh to set up your backup set (or run 
$OBM_HOME/bin/Configurator.sh if you are in command line mode. Then use the 
web interface to set up your backup sources and other settings) 

5. Run $OBM_HOME/bin/RunBackupSet.sh [BACKUP_SET_NAME] to run your backup 

6. Run $OBM_HOME/bin/Scheduler.sh to start the backup scheduler 

 
^Back to top

1.7. The Windows version of OBM installer hangs, what could be the 
problem? 

There are a few things that could create errors during or after executing the installer. 

1. Make sure there is enough disk space on the machine. 
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2. Make sure you do not have any anti-virus software or pcAnywhere running, as this 
may create problems with InstallAnywhere installers.  

3. There are also problems with InstallAnywhere installers and Dell OpenManager. If 
OpenManager is installed on the target system, be sure to disable it before installing 
OBM. 

4. Hardware could cause errors as well. Try setting your [hardware acceleration display 
setting] to off. There are problems with certain versions of Java running along with 
certain video cards. 

5. This may only be a Java problem. 

Also, be sure the file size is valid and you are transferring the file in binary mode. 
 
Java Testing 

Please try running any of the Swing demos that came with the Java runtime in 1.4.X and see 
if it hangs on Windows. In order to fix this problem, some knowledge bases on the Internet 
suggest updating DirectX to at least DirectX 8.1. Most machines that got this problem had 
DirectX 7.0 installed. (You can use the “dxdiag” command to find out the directX version) 

SUN recommends two workarounds for certain video card issues 

1. The following will pass properties to the installer's Virtual Machine: 
In Advanced Designer – Project -> Config -> Additional Arguments 
set that to "-Dsun.java2d.d3d=false -Dsun.java2d.noddraw=true" without the 
quotes. 

2. Set the following lax property in your LaunchAnywhere for your application's JVM:  
lax.nl.java.option.additional=-Dsun.java2d.d3d=false -Dsun.java2d.noddraw=true 
 
Add the same line to the uninstaller lax file, using a modify file action in your installer 
in post-install. 

 
^Back to top

1.8. The Installer doesn’t seem to work. How can I manually install OBM 
on Windows? 

To manually install OBM on Windows, you’ll need to copy and zip the program directory (e.g. 
C:\Program Files\OBM) from another machine with OBM installed. Then do the following on 
the machine you wish to manually install:  

1. Create the directory C:\Program Files\OBM 

2. Unzip the OBM program directory archive to C:\Program Files\OBM 

3. Run C:\Program Files\OBM\bin\install.bat 

4. Run C:\Program Files\OBM\bin\Install-Scheduler.bat 

 
^Back to top

1.9. The Installer doesn’t seem to work. How can I manually install OBM 
on Mac? 

Try manually installing OBM on your Mac with the following instructions: 

1. Choose Save, not Open, at 
http://MyBox.BackupDepositBox.com/obs/download/obm-mac.zip  

2. Expand obm50-mac.zip into /Applications/OBM 

3. Run "chmod -R 755 /Applications/OBM" using Terminal 

4. Double-click the “Online Backup Manager” icon in the /Applications/OBM folder 

 
^Back to top

1.10. Error occurred when Installing OBM on Novell. 

Some users would have problems when trying to install OBM on Novell Netware. (The 
machine had met all the system requirements: Netware v5.1 and Netware Java v1.3.1). The 
user could receive the following error message during installation. 

 

http://mybox.backupdepositbox.com/obs/download/obm-mac.zip
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Exception in thread "main" 
Java.lang.noclass def found error.obm 
Java: class obm exited with status 1 

 
Check the following 

Please check if the OBM_HOME environment variable in SYS:\OBM\bin\BackupManager.ncf 
is correct. 

 

envset OBM_HOME=SYS:\OBM 

envset OBM_CLASSPATH=$OBM_HOME\bin;$OBM_HOME\bin\obm.jar; 
$OBM_HOME\bin\obm-lib.jar 

envset LIB_PATH=$OBM_HOME\bin 

java -mx384m -Djava.library.path=$LIB_PATH -cp $OBM_CLASSPATH obm SYS:\OBM 

 

Please change the SYS:\OBM environment variable to your installation directory. 

 
^Back to top

1.11. Are there any command line tools for OBM? 

Yes, there are scripts in the [OBM Program Home]\bin and they are described below: 
 
Windows 

 Decrypt.bat: decrypts the specified backup files 

 install.bat: installs the OBM icon to the System Tray and registers the Online Backup 
Scheduler as a service 

 Install-Scheduler.bat: registers the Online Backup Scheduler as a service 

 RegisterVSS.bat: re-registers Microsoft’s Volume Shadow Copy service DLLs 

 Remove-Scheduler.bat: un-registers the Online Backup Scheduler service 

 Restore.bat: restores the specified snapshot of the backup set to the specified 
location 

 RunBackupSet.bat: runs the specified backup set 

 RunOBM.bat: launches the Online Backup Manager user interface 

 Run-Scheduler.bat: starts the Online Backup Scheduler service 

 SeedLoad.bat: runs seed load for the specified backup set to the specified location 

 Uninstall.bat: removes the OBM icon from the System Tray and un-registers the 
Online Backup Scheduler service 

Linux 

 BackupManager.sh: launches the Online Backup Manager user interface 

 Configurator.sh: configures client parameters such as Backup Server address, 
username/password, encrypting key, etc. 

 Decrypt.sh: decrypts the specified backup files 

 Restore.sh: restores the specified snapshot of the backup set to the specified location 

 RunBackupSet.sh: runs the specified backup set 

 Scheduler.sh: starts the Online Backup Scheduler service 

 SeedLoad.sh: runs seed load for the specified backup set to the specified location 

 StopScheduler.sh: stops the Online Backup Scheduler service 

 
*You may have to set some variables in these scripts. 
 
^Back to top
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1.12. How does OBM detect changes in files? Does it use the Archive 
bit? Some tape backup software resets the Archive bit. Would this 
affect OBM when backing up the same data? 

OBM compares timestamps of files on the offsite server with the corresponding copies on the 
sending machine. The archive bit is not used since it does not detect relocated files. 
Therefore, tape backup, or any other kind that changes the archive bit, would not affect OBM, 
and OBM does not affect them.  
 
^Back to top

1.13. Does OBM copy the same set of files regularly? 

After the initial upload, subsequent backup jobs will only transfer the modified or new data to 
the Backup server. It depends on the nature of the data, but normally, less than 2% of all 
data is modified per day.  
 
^Back to top

1.14. Transfer Block Size is 128Kb by default. Is there a reason for this? 

Backup data is transferred in blocks (instead of file by file) to minimize connection 
negotiation roundtrips. This setting is optimal for the backup operation. This is not the TCP/IP 
block size.  
 
^Back to top

1.15. How can I back up a huge data set over the Internet? 

If you have a lot of data (e.g. 300GB) to back up to the backup server, it would take a 
considerable amount of time to perform the first full backup over the Internet. You can try the 
following method:  

1. Use the Seed Loading Utility to back up your backup set to a local external hard disk 
(instead of directly transfer to the backup server)  

2. Send the external hard disk to your backup service provider.  

3. The backup service provider will then load all your backup files from your external hard 
disk into your backup account. This could save days (even weeks) of performing your 
first full backup.  

Subsequent backups are incremental. Only new or updated files will be uploaded to the 
server. The amount of data transfer over the Internet should be relatively small.  
 
Please refer to the User’s Guide for details on the “Seed Loading Utility”. 
 
^Back to top

1.16. What is the best way to restore a huge data set? 

Your backup service provider can copy the data of the particular backup set on the BDB to 
removable media, e.g. external hard disk or DVDs, and ship it to you. You can then use the 
“Decrypt Files Tool” in OBM to restore the backup data. 
 
^Back to top

1.17. Does In-File Delta backup require a temporary working directory?  

OBM requires temporary storage for the delta file before it gets sent to the BDB server.  

For example:  

If you have a 10GB file that has already been backed up to the server and you have 
updated 10MB of this file, you need to have at least 10MB of free space in the temporary 
directory for the delta file. You do not need 10GB of free disk space.  

 



 committed to your peace of mind 
Backup Deposit Box

 Technical FAQ
 

The InfoTech Group Page 10 of 29 9-30-2007

 

Also, if you want to back up 5 different 10GB files, you will only need 10MB of free space, not 
5 x 10MB, because each delta file will be automatically deleted right after it has been backed 
up. The temporary space will be re-used for each of the 5 transactions.  

 
^Back to top

1.18. What is the average compression ratio? 

All backup files are compressed and encrypted before uploading to the backup server. The 
average compression ratio for a text-based file is around 4:1. However, no further 
compression can be made on files that are already in compressed format (e.g. JPG, ZIP). In 
general, you can assume a 2:1 compression ratio when you are backing up a file set with a 
variety of types. 
 
^Back to top

1.19. Can I change my encrypting key? 

The encrypting key for any one backup set cannot be changed. This is necessary for the 
integrity of the backup set. Different backup sets may have different keys, but the key used 
to restore a set must be the same one used to create that set. 
 
You need to recreate your Backup Set if you really want to change your encrypting key.  
 
^Back to top

1.20. The “Use Login Password as Encrypting Key” option was selected 
when creating the backup set. Why can’t I restore the backup data 
with my most current login password? 

By selecting the “User Login Password as Encrypting Key” option when creating a backup set, 
OBM will set your login password as the encrypting key for the backup set. Once set, even if 
you change your login password afterward, the encrypting key will remain as your original 
password. In other words, if you have changed your login password, you still need to use the 
original password to decrypt and restore the backup set. 
 
Currently, if the encrypting key is forgotten or lost, the backup set can never be restored. It 
is not possible to restore without the key used in the creation of the set. 
 
You can find out more from  
http://MyBox.BackupDepositBox.com/obs/download/EncryptingKey.jpg  
 
^Back to top

1.21. What kind of encryption is used by OBM? 

There are two encryption types used: 
 

1. Encryption of backup data - This is being done by 128-bit symmetric key 
encryption (AES, TripleDES, TwoFish), what is currently being used by most banks. 

2. Encryption of backup traffic - This is being done by 1024 bit RSA public key 
encryption. The strength of the encryption depends on the key size you use when you 
generate your CSR before submitting to your Certificate Authority (CA). 1024 bit is 
what is being used by most CAs. 

 
^Back to top

 

http://mybox.backupdepositbox.com/obs/download/EncryptingKey.jpg
http://mybox.backupdepositbox.com/obs/download/EncryptingKey.jpg
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1.22. When I select the backup option “local hard drive” to back up to an 
external hard drive, it fails in the middle of the process. Why? 

Please check if the external hard drive is in FAT32 format. And also check whether there is 
any folder containing more than 32000 files and there is no file bigger than 4GB, a FAT32 
limitation. You may try to convert the FAT32 volume to NTFS.   
 
^Back to top

1.23. Scheduled backup jobs are not running on my Windows machine. 
Why? 

Please try the following: 
 

1. Check if [Control Panel] -> [Administrative Tools] -> [Services] -> [Online Backup 
Scheduler] is available and started 

2. Check if C:\Program Files\OBM\home.txt contains the home directory for your 
backup account (e.g. C:\Documents and Settings\Administrator\.obm) 

3. Check if C:\Program Files\OBM\jvm\bin\SchedulerOBM.exe exists 

4. Check if C:\Program Files\OBM\log\Scheduler\info.log contains the startup loading 
entry, e.g. 

i. [2005/12/12 12:42:44] OS Name=Windows XP 

ii. [2005/12/12 12:42:44] OS Version=5.1 

iii. [2005/12/12 12:42:44] Scheduler Version=5.0.1.3e 

iv. [2005/12/12 12:42:44] Java Vendor=Sun Microsystems Inc. Version=1.4.2_10 

v. [2005/12/12 12:42:44] [info] Starting Scheduler, User:'backup-account', 
Home:'C:\Documents and Settings\Administrator\.obm' 

5. Check if C:\Documents and Settings\Administrator\.obm\log\Scheduler\debug.log 
contains the debugging information for your scheduler 

 
If your system settings are not the same as above, please download a new installer 
(obm-win.exe) from our website and try again. 
 
^Back to top

1.24. I am having problems with my scheduled backup. Why? 

If you are backing up files from a network drive, please check if you have included the valid 
“Network Resources Authentication” information for the backup set. This is required for 
scheduled backups that access any network resources.  

You can refer to the following screenshot: 

http://MyBox.BackupDepositBox.com/download/Network-Resources-Authentication.jpg  

 
^Back to top

1.25. I cannot get proxy authentication to work with OBM. Why? 

If you are using port 80, please check whether your proxy server accepts "HTTP CONNECT" 
calls on port 80. You may also want to try other ports like 443 to see if your proxy server 
accepts that. 
 
^Back to top

1.26. Can I back up an entire Operating System? 

Yes and No. You can backup/restore the operating system by doing the following, but this is 
not hard disk imaging: 
 
To back up all files including the operating system, please do this: 

 

http://mybox.backupdepositbox.com/download/Network-Resources-Authentication.jpg
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1. Add all files to your backup source 

2. Add a System State backup type to your backup account (Windows only) 

 
To restore all files including the operating system, please do this: 

1. Re-install the operating system and applications 

2. Restore the System State backup to your machine (Windows only) 
(To restore the System State data on a server that is a domain controller, you must 
first start your server in "Directory Services Restore Mode"). To access "Directory 
Services Restore Mode", press F8 during startup and select it from the list of startup 
options. Restore the System State. 

3. Restore all files to your machine 

 
^Back to top

1.27. When setting up a Microsoft SQL backup set, I cannot list the 
available SQL servers. What can I do? 

You can try running “osql –L” at a command prompt. You should see the following: 
 
Servers: 
    (local) 
    SQLSERVER1\INSTANCE1 
    SQLSERVER2\INSTANCE2 
 
If you have a firewall installed, please disable it. UDP Broadcast must be allowed. 
 
^Back to top

1.28. Why are the Microsoft SQL Server databases missing from the 
backup source list?  

If you have firewall installed on your network, please make sure UDP port 1434 is allowed on 
the SQL Server.  
 
^Back to top

1.29. How do I set the recovery model of a MS SQL database to FULL? 

You can change the recovery model by running the following commands with each of the 
database that you want to run transaction log backup. 

C:\> osql -E -S SQLSERVER1\INSTANCE1 -Q "ALTER DATABASE xxx SET RECOVERY FULL" 

    Where 

SQLSERVER1\INSTANCE1 = the SQL Server and the corresponding instance 

xxx = the name of the database 

 
^Back to top

1.30. Windows network map drive connections are not stable. Why? 

You may want to try editing a few Windows Parameters. 
 

SMB Size 

When running applications that copy or move a large amount of data to a remote server, the 
speed of such action is determined by network speed and by the SMB (a protocol related to 
Windows drive mapping) size.  

NT/2000 negotiates the SMB size and will generally set this to 4K blocks for applications that 
are moving or copying data to a remote server. By increasing this block size, you will allow 
the server to complete its file copies faster. This will increase the performance of the 
application making the copy/move calls. 
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HKEY_LOCAL_MACHINE\System\Current Control Set\Services\LanmanServer\Paramerters 

 

"SizReqBuf"= REG_DWORD 

Set Value To: 16000 = HEXDEC 

Ref: http://support.microsoft.com/default.aspx?scid=kb;en-us;320829

     

Map Drive Auto Disconnect Settings 

Reference: http://support.microsoft.com/kb/138365/EN-US/

http://support.microsoft.com/default.aspx?scid=kb;en-us;297684  

 

HKEY_LOCAL_MACHINE\System\Current Control Set\Services\LanmanServer\Paramerters 

 

Autodisconnect to: fffffff 

 

Creating a .bat file for better performance 

If you are still having problems, you may want create a bat file and schedule this file to run 
every 10 minutes. Try: 

.bat file settings: 
-------------------------- 

ping mapdrv 
ping 192.168.1.15 
net config server /autodisconnect:-1 
net use /persistent:yes 
net use "\\mapdrv\DATA STORAGE1" 
net use "\\192.168.1.15\DATA 
net use d: \\192.168.1.15\DATA STORAGE1 
net use e: "\\mapdrv\DATA STORAGE1" 
dir d:\  
dir e:\  

-------------------------- 

 mapdrv = your Network Attached Storage (NAS) device network name 

 192.168.1.15 = mapdrv 

 
In addition, create a host file on the server hosting the program with the following entry in it:  

 mapdrv = 192.168.1.15 
 
And if you are on a 2003 server, refer to the following: 
Reference: http://support.microsoft.com/default.aspx?scid=kb;en-us;890553  
 
For Windows 2000, you may want to install the following Hotfix: 
Windows2000-KB903237-x86-ENU 
Reference: http://support.microsoft.com/default.aspx?scid=kb;en-us;903237  
 
^Back to top

1.31. There is an error when backing up files on a remote NetWare 
server. What can I do? 

If you want to back up \\SERVER\SHARE that is located on a NetWare server and you are 
getting a "Network drive is not accessible" error message, try adding the following 
command as a [Pre-backup command]  
 
net use \\SERVER\SHARE [PASSWORD] /USER:[DOMAIN | MACHINE_NAME]\[USERNAME] 
 
This will authenticate the current process with the NetWare server and therefore allow your 
backup to run correctly. 
 
^Back to top

 

http://support.microsoft.com/default.aspx?scid=kb;en-us;320829
http://support.microsoft.com/kb/138365/EN-US/
http://support.microsoft.com/default.aspx?scid=kb;en-us;297684
http://support.microsoft.com/default.aspx?scid=kb;en-us;890553
http://support.microsoft.com/default.aspx?scid=kb;en-us;903237
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1.32. What are the advantages and disadvantages of backing up multiple 
computers using a single backup account?  

Advantages 

 You require less backup accounts 

 You can use one username and password to configure the backup setting for all 
backup sets 

Disadvantages 

 Whenever a new backup set is created under the backup account, you need to go 
back to all computers using the same backup account to uncheck the “Run 
scheduled backup on this computer” option for the new backup set (Since the 
backup setting is saved on the offsite backup server and the new backup set is the 
default to run, it affects all computers, i.e. the option for the new backup set is 
checked). 

 Improper configuration could easily cause problems that are difficult to debug. 

 
^Back to top

1.33. Does the OBM upgrade the installation of Java on a client machine, 
or does it install a separate copy for its own use?  

OBM uses its own copy of Java and leaves the system Java VM intact. 
 
^Back to top

1.34. Is it possible to do incremental or differential backups with 
MySQL? 

Yes and No. Our In-File Delta feature ensures that only the changed data blocks within the 
dump file are uploaded to the Backup Server. MySQL backup is done with a SQL Dump file, 
and it generates a single file. In-File Delta can upload just the changed portion of the file, 
even though mysqldump cannot do an incremental dump. 
 
^Back to top

1.35. How does the “Remove retention files for overlap policy” under 
Advanced Retention Policy work? 

In general, daily snapshots followed by a weekly snapshot or a monthly snapshot, etc. will be 
removed; weekly snapshots followed by a monthly snapshot or a quarterly snapshot, etc. will 
be removed; and so on.  
 

This is illustrated by the following example. 

Assume today is 17Jan06, and the Advanced Retention Policy is as follows:  

 Daily: retain for 7 days 

 Weekly: retain for 4 weeks (the job will be performed on Saturday) 

 Monthly: retain for 3 months (the job will be performed on the 1st of each month) 

If “Remove retention files for overlap policy” is NOT enabled: 

Then a total of 14 snapshots (7+4+3) will be kept on the server, i.e.:  

(Daily): 10Jan06, 11Jan06, 12Jan06, 13Jan06, 14Jan06, 15Jan06, 16Jan06 
(Weekly): 24Dec05, 31Dec05, 7Jan06, 14Jan06 
(Monthly): 1Nov05, 1Dec05, 1Jan06 

If “Remove retention files for overlap policy” is enabled: 

Then only the following snapshots are kept: 1Nov05, 1Dec05, 1Jan06, 14Jan06, 15Jan06, 
16Jan06.  
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Specifically, the weekly policy overrides the daily policy so 10Jan06, 11Jan06, 12Jan06 and 
13Jan06 will be removed. The monthly policy overrides the weekly policy, and 24Dec05, 
31Dec05 and 7Jan06 will be removed. 
 
^Back to top

1.36. What is incremental backup and how does In-File Delta work? 

In an incremental backup, only modified files will be uploaded to the Backup Server.  
 
In-File Delta is applicable to the physical files to be uploaded to the Backup Server. It does 
not matter whether it is a MS SQL database file, MS Exchange transaction log file or any 
normal file in a File Backup Set. Only the changed blocks, in comparison to the original file, 
will be uploaded. 
 
For each modified file, OBM would determine whether the entire file or only delta file should 
be uploaded. If the entire file is to be uploaded, the old version of the file will be moved to the 
Retention area. If only the delta file is to be uploaded, the previous delta files will be moved 
to the Retention area and the Data area will contain the original full backup file, checksum file 
and the latest delta file of this file.  
 
^Back to top

1.37. How does the “Auto” block size work under In-file Delta settings? 

If the block size is set to “Auto”, the effective block size (Started from OBM v5.0.1.7) will be 
chosen from the following table based on the file size of the updated file: 
 
 File Size   Delta Block Size 
 ------------  ---------------- 
 0 - 500M      4k 
 500M - 2G     8k 
 2G - 8G       16k 
 8G - 15G      32k 
 > 15G         64k 
 
^Back to top

1.38. What happens when we do In-File Delta backup on a directory? 

When you do backup, the Online Backup software will do the following: 

1. Check if any files are added, updated or deleted (the calculation of these files are 
based on files having the same filename). 

2. New files will be uploaded to the server in whole. 

3. Deleted files will be removed from Data area and placed into the Retention area on 
the Backup server. 

4. Updated files will be processed by the In-File Delta option (i.e. only changed data 
blocks within the files will be uploaded to the Backup Server) 

 
^Back to top

1.39. Does OBM have to stop an application when doing online 
backups? 

OBM can back up application data while an application is still running. We have special agents 
for MS Exchange Server, MS SQL Server, Oracle, Lotus Notes and MySQL, which allow these 
applications to be backed up while they are active. With the Volume Shadow Copy feature 
started from OBM v5.0, we are able to back up other types of applications while they are 
active. 
 
^Back to top
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1.40. What are Off-line Backup, Logout Backup Reminder and Local 
Backup features? 

Off-line Backup is designed for notebook users who are off-line most of the time, and 
cannot rely on a backup schedule to back up regularly. The backup interval allows notebook 
users to specify the interval that they would like their data to back up. If this interval has 
elapsed, backup will run automatically once this machine is connected. 
 
Logout Backup Reminder asks if backup should be done at logout or shutdown. 
 
Local Backup allows an extra copy of backup to be kept on a local hard disk when backup is 
running. 
 
^Back to top

1.41. Why is my OBM running backup once every hour? 

You might have “Off-line Backup” enabled for every hour. Please do the following to disable 
that:  

1. Log on to OBM  

2. Select the backup set in the left panel 

3. Select the [Extra Backup] node under the backup set node in the left panel 

4. Uncheck the [Enable off-line backup] checkbox under the “Off-line Backup” section 

5. If you want to do this to all backup sets, please repeat the previous steps for each 
backup set 

Press the [Save Setting] button on the toolbar 
 

^Back to top

1.42. How do I disable “logout backup reminder”? 

To disable the “System Logout Backup Reminder”, please do the following: 

1. Log on to OBM  

2. Select the backup set in the left panel 

3. Select the [Extra Backup] node under the backup set node in the left panel 

4. Uncheck the [Enable System Logout Backup Reminder] checkbox under the “System 
Logout Backup Reminder (Windows)” section 

5. If you want to do this to all backup sets, please repeat the previous steps for each 
backup set 

Press the [Save Setting] button on the toolbar 

 
^Back to top

1.43. How do I upgrade OBM from V4.5 on Linux? 

Please do the following for this upgrade: 

1. Shut down the backup scheduler by running "touch 
$OBM_HOME/ipc/Scheduler/stop" 

2. Make the directory ~/.obm 

3. Move old $OBM_HOME/log and $OBM_HOME/config to ~/.obm  

4. Rename $OBM_HOME to $OBM_HOME.bak 

5. Install new OBM to $OBM_HOME and expand all files into $OBM_HOME 

6. Run $OBM_HOME/bin/BackupManager.sh (or $OBM_HOME/bin/Configurator.sh if in 
command line mode) to configure your backup set. All your old settings should still be 
there. 

7. Run $OBM_HOME/bin/Scheduler.sh to start the backup scheduler (you must have 
run $OBM_HOME/bin/BackupManager.sh or $OBM_HOME/bin/Configurator.sh once, 
before starting up the scheduler) 
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^Back to top

1.44. How do I change the .obm path for Novell?  

Please take a look at SYS:\OBM\home.txt. It contains the path to the .obm directory. You can 
do the following to make the changes: 

1. Stop the scheduler  

2. Change the entry in SYS:\OBM\home.txt to another directory  

3. Copy the .obm directory from the existing location to the new location 

4. Start the scheduler 

5. Open “SYS:\OBM\bin\BackupManager.ncf” and append the updated .obm path to the 
end of the whole command line. 

Example 

java -mx384m -Djava.library.path=$LIB_PATH -cp $OBM_CLASSPATH obm 
SYS:\OBM C:\[new location]\.obm 

 
^Back to top

1.45. The MS SQL or MS Exchange database backup job stores 2 copies 
of the spooled database file in the "temporary directory" (tagged 
with different datetimes). This has taken up extra disk space. Is this 
necessary?  

If you have interrupted any of the backup jobs, the file tagged with the datetime of the 
corresponding backup job will be renamed to its original file name just before it is uploaded. 
This is necessary as we need to ensure that the snapshot of different dates will not overwrite 
each other. 
 
If a backup job is still running, just let it run to completion. If backup has been stopped, just 
remove all files tagged with the corresponding datetime in the “temporary directory” and try 
to perform a full database backup again. 
 
^Back to top

1.46. What do I have to do in order to back up open files? 

You need to be on OBM v5.0 or above, as well as have support from the underlying Operating 
System (OS). Windows XP and 2003, by default, come with Volume Shadow Copy, which 
allows the backup of open files. For older platforms, e.g. Windows 9x/ME/NT/2000 or 
NetWare, we recommend using a third party open file manager (e.g. St. Bernard Open File 
Manager - http://www.stbernard.com/) if open file backup is required. 
 
*Open file option is not required on Linux/Unix/Mac OS X because no files are held exclusively open by 
applications, normally a limitation, but in this case a useful feature. 
 
^Back to top

1.47. How does Volume Shadow Copy work? 

Please refer to: 
http://technet2.microsoft.com/WindowsServer/en/Library/2b0d2457-b7d8-42c3-b6c9-59c
145b7765f1033.mspx  
 
^Back to top

 

http://www.stbernard.com/
http://technet2.microsoft.com/WindowsServer/en/Library/2b0d2457-b7d8-42c3-b6c9-59c145b7765f1033.mspx
http://technet2.microsoft.com/WindowsServer/en/Library/2b0d2457-b7d8-42c3-b6c9-59c145b7765f1033.mspx
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1.48. In Windows, when OBM is creating a Shadow Copy Set, it gets the 
“[ERROR] E_UNEXPECTED” error. What can I do? 

This is a Microsoft Volume Shadow Copy issue. Microsoft's recommendation is to try 
re-registering the Volume Shadow Copy Service. If you are on Win XP Pro, you can simply run 
the batch file available in C:\Program Files\OBM\bin\RegisterVSS.bat or use the one we 
provide for you at 

http://MyBox.BackupDepositBox.com/download/RegisterVSS.bat  

 
^Back to top

1.49. How do I back up Oracle 7.3.4 on NetWare? 

To back up Oracle 7.3.4 on NetWare 5.1, you need to do the following: 

1. Back up all Oracle 7.3.4 data files, control files, and pfile. 

2. Use "exp" (export utility) to dump the Oracle database to a dump file (use the 
pre-backup command in OBM) 

3. Use OBM to back up this file 

 
It is not possible to use the Oracle agent. 
 
When you need to restore the database, just restore all data files, control files, pfile to the 
original location and use "imp" (import utility) to put the data back into the Oracle database. 
 
^Back to top

1.50. How do I back up NTFS permissions? 

For version 5.1 or later, NTFS permissions are also backed up. For other versions, please do 
the following: 

1. Download and install 
http://www.microsoft.com/downloads/details.aspx?FamilyID=E8BA3E56-D8FE-4A9
1-93CF-ED6985E3927B&displaylang=en  

2. Add a pre-backup command to dump the NTFS permissions of all files you want to 
back up into a dump file. For example, if you want to have all files under the C:\ drive 
saved to C:\NTFS-Permission.txt, please add 
 
"C:\Program Files\Windows Resource Kits\Tools\subinacl" /noverbose 
/outputlog=C:\NTFS-Permission.txt /subdirectories C:\*.* /display 
 
to your pre-backup command. 

3. Add "C:\NTFS-Permission.txt" to the [Backup Source] of this backup set 

 
^Back to top

1.51. How do I restore NTFS permissions? 

For version 5.1 or later, the backed up NTFS permissions will be restored automatically. For 
other versions, assuming the NTFS Permissions are being stored in 
"C:\NTFS-Permission.txt", please do the following: 

1. Restore "C:\NTFS-Permission.txt" from the backup server using OBM 

2. Apply all NTFS permissions to all your backup files by running:  
 
"C:\Program Files\Windows Resource Kits\Tools\subinacl" /playfile 
C:\NTFS-Permission.txt 

 
^Back to top

 

http://mybox.backupdepositbox.com/download/RegisterVSS.bat
http://www.microsoft.com/downloads/details.aspx?FamilyID=E8BA3E56-D8FE-4A91-93CF-ED6985E3927B&displaylang=en
http://www.microsoft.com/downloads/details.aspx?FamilyID=E8BA3E56-D8FE-4A91-93CF-ED6985E3927B&displaylang=en
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1.52. How do I back up file permissions in Linux? 

For version 5.1 or later, Linux file permissions are also backed up. For other versions, please 
do the following: 
 

1. Add a pre-backup command to dump the Access Control List of all files you want to 
back up into a dump file. For example, if you want to have all files under /home saved 
to /ACL.txt, please add: 
 
   cd /; getfacl -R home > ACL.txt  
 
to your pre-backup command. 

2. Add "/ACL.txt" to the [Backup Source] of this backup set 

 
^Back to top

1.53. How do I restore file permissions in Linux? 

For version 5.1 or later, the backed up Linux file permissions will be restored automatically. 
For other versions, assuming the Access Control Lists are being stored in "/ACL.txt", please 
do the following: 

1. Restore "/ACL.txt" from the backup server using OBM 

2. Apply all Access Control Lists to all your backup files by running  
 
   cd /; setfacl --restore=ACL.txt 

 
^Back to top

1.54. How do I remove OBM completely from my Windows machine? 

If you want to completely remove OBM from Windows, after uninstalling the software from 
[Control Panel] -> [Add or Remove Programs], please do the following: 

 Ensure that the OBM installation directory is deleted (sometimes not removed 
automatically) 

 Remove the C:\Documents and Settings\administrator\.obm\ folder (intentionally 
left undeleted, since important information is there about the user, backup sets, and 
the encryption keys) 

 
^Back to top

1.55. Does OBM work with dial-up connections? 

Yes. It makes no difference to OBM if the connection is always on or not.  
 
And this is nice: If you want Windows to connect to the ISP automatically when a backup 
starts, you can go to [Control Panel] -> [Internet Options] -> [Connections] and select 
“Always dial my default connection”.  
 
^Back to top

1.56. The OBM crashes when opening [Backup Source] of a Lotus 
Domino/Notes backup set. What can I do? 

Check to see if you can find the hs_err_pid????.log file under [OBM Home], and if it contains 
the error "Unable to complete restart processing, err = Recovery Manager: Error from 
Logging Subsystem", please do the following: 

1. Go to [Configuration], select [All Server Documents] and choose your corresponding 
server.  

2. [Disable] Transactional logging at Basics 
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3. Go to [Control Panel] -> [Administrative Tools] -> [Services] and restart [Lotus 
Domain Server] Service 

4. Go to [Configuration] -> select [All Server Documents] and enable Transaction 
Logging 

5. Make sure your logging style is "Archived" 

6. Go to [Services] and restart Lotus Domain Server Service again 

 
^Back to top

1.57. How do I restore a machine from my System State backup? 

To recover a machine from scratch, do the following: 

1. Re-install the operating system (or restore a drive image – see step 2) 

2. Re-install all applications installed (you can accomplish the same result as both step 
1 and step 2 by re-imaging a hard drive from an image taken of the whole system 
after any updates and software installations. Use imaging software like Ghost, Drive 
Image Pro, Acronis, or StorageCraft to do so. If you do this, start by using the image 
instead of performing step 1 and the re-installation of applications of step 2. 

3. Restore the System State backup. This will update the recovered system with the 
latest configuration and settings. 

4. Restore all data files to the recovered system. 

 
^Back to top
  

1.58. What is the limit on file size that BDB can back up? 

There is no limitation on the file size at the application level. Instead, this limitation is 
imposed by the underlying operating system. With modern operating systems, you should 
have no problem backing up files at a few TB in size (e.g. NTFS has a file size limit of 16TB). 
 
^Back to top
 

1.59. Is 128-bit SSL secure enough for communication between OBM 
and BDB? 

Under most situations, 128-bit is already more than enough for commercial use (Please see 
http://MyBox.BackupDepositBox.com/download/BDB-Security.htm). Also, encryption 
strength doesn't rely solely on the number of bits used in the encryption. The choice of a 
random source and random salt are just as important. In addition, the backup data are 
encrypted and compressed before sending, which enhances the security. 
 
^Back to top

1.60. How is data privacy being maintained on BDB? 

All data are encrypted with the user's defined encrypting key before they are sent to the 
online backup server. The encrypting key is not stored on the BDB server or any other device. 
Without the encrypting key, the backup files are useless to anyone, including the owner and 
staff at BDB/ITG. The backup user is the only person who can decrypt the backup files to 
reveal/use the original content.  
 
^Back to top

1.61. What is the purpose of the Retention area? 

Deleted and modified files in the current backup are moved to the Retention area in BDB, 
where they will stay as defined by the retention policy of the backup set. You can restore 
those files that are still in the Retention area. The purpose of the Retention area is to facilitate 

 

http://mybox.backupdepositbox.com/download/BDB-Security.htm
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retrieval of historical snapshots of a backup set, i.e. to have prior backup versions, not just 
the latest version. 
 
Note that the data in the Retention area still counts towards your quota. To save more 
versions, your usage may necessitate an increase in your quota, which may increase your 
charges. Conversely, to reduce your charges, if fewer versions are retained and the result 
drops the storage to less than another quota price point, you could change your plan to one 
that has a lesser charge. Retained versions stay in the Retention area as defined by your 
retention policy. 
 
 
^Back to top

1.62. May I see an example of how the Retention area works? 

Suppose you have 10GB of initial data which grows by 200MB (0.2GB) per day, and on each 
day 100MB (0.1GB) of the data is modified or deleted from the source machine. Assume you 
take the default retention policy setting of 7 days. Then, 
 
Day 0: Data = 10G; Retention = 0; Total quota used = 10G; 
Day 1: Data = 10.2G; Retention = 0.1G; Total quota used = 10.3G; 
Day 2: Data = 10.4G; Retention = 0.2G; Total quota used = 10.6G; 
... 
Day 7: Data = 11.4G; Retention = 0.7G; Total quota used = 12.1G; 
Day 8: Data = 11.6G; Retention = 0.7G; Total quota used = 12.3G; 
          (The 0.1G from Day 1 is removed from the Retention area) 
Day 9: Data = 11.8G; Retention = 0.7G; Total quota used = 12.5G; 
          (The 0.1G from Day 2 is removed from the Retention area) 
…and so on 
 
Therefore if data is not being modified or deleted frequently, then the size of Retention area 
should be minimal. 
 
^Back to top

1.63. Is it possible to keep 5 years of backup? If so, do I need to set the 
retention policy to 1825 days? 

Yes. You might set days to 1825 or not to accomplish this. It depends on your backup 
requirements. If you need to be able to restore any of the snapshots for any of those 1825 
days, then yes, you need to set a 1825-day retention policy.  
 
On the other hand, if you only need the snapshots of 31 December for 5 years, then you can 
make use of the "Advanced Retention Policy" feature, where you have options to keep yearly, 
quarterly, monthly, weekly or daily snapshots. With this flexibility, you should be able to 
configure your desired backup policy to meet your needs without unnecessary storage and 
costs. 
 
^Back to top

1.64. Unmodified files are not uploaded to BDB regularly. Is this normal? 

Only files that have been deleted or have been updated by a newer version are stored in the 
Retention Area. All other files stay in the Data Area as the current copy and they are not 
affected by the retention policy. In other words, unmodified files could stay in the BDB 
forever. 
 
^Back to top

1.65. Is there a tool to verify the integrity of the backup data on BDB? 

The BDB software already has a built-in checksum mechanism to ensure integrity. When a 
file is uploaded, the BDB server verifies the checksum before marking it as a successfully 
transferred file. 
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In addition, there is a weekly "Rebuild User Storage" batch job, configurable under 
[Manage System] -> [Routine Job] -> [System Job] section in the BDB Management Console 
that staff at BDB may use. This is to ensure that all backup files are validated and no errors 
occur when users need to restore files.  
The settings are as follows: 

 Enable File Validation 

 Verify “Filesize & Checksum" - Verify the backup file size with its expected values, 
and the checksum of the backup file with the value saved during upload 

 Verify “Filesize Only” – Only verify the backup file size with its expected values 
*Note that if the [Enable File Validation] is unchecked, it would not validate if the actual file size 
has changed.  

 Corrupted File Action 

 "Log information only" - Just log it in the system log and do nothing 

 "Move to retention dir" - Back it up in [User Homes]\[User Login]\errFiles and 
remove this file from the Data area 

 

You may request this process be performed on your data at any time. Do so by e-mail. There 
is no charge as long as it is requested once per month or less. If requested more often, the 
additional labor for the job and a reply e-mail report will be charged at our current published 
rate, which you may find on the Backup Deposit Box web page. 
 
^Back to top

1.66. How do I rename a backup account on BDB? 

You can request this from the staff at BDB. See the BDB web page support area. 
 
^Back to top

1.67. Can I change the Backup Client type between ACB User and OBM 
User? 

Yes. You need to make the request by email. 

 
^Back to top

1.68. Is it possible to move backups from one account to another? Can 
the data be merged into an existing account? 

Yes, it is possible. You may make the request by email. 

 
^Back to top

1.69. What is the average speed for replication? 

The following is data obtained from the replication speed test conducted using two machines 
(for both BDB and RPS) running Intel Xeon 3.2GHz with 2GB of RAM over a 2M/2M DSL line 
with both SSL and encryption enabled: 
 

485 04:22:10 PM Replicating 'D:\BDB-Data\system\logfiles\log04b5.alf' (9.9M) 

486 04:22:53 PM Replicating 'D:\BDB-Data\system\logfiles\log04b6.alf' (10M) 

487 04:23:37 PM Replicating 'D:\BDB-Data\system\logfiles\log04b7.alf' (9.8M) 

488 04:24:24 PM Replicating 'D:\BDB-Data\system\logfiles\log04b8.alf' (9.9M) 

489 04:25:08 PM Replicating 'D:\BDB-Data\system\logfiles\log04b9.alf' (9.8M) 

490 04:26:53 PM Replicating 'D:\BDB-Data\system\logfiles\log04ba.alf' (9.9M) 

491 04:27:48 PM Replicating 'D:\BDB-Data\system\logfiles\log04bb.alf' (9.9M) 
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The following is data we obtained from a similar test over 100Mb Ethernet: 
 

103 08:11:38 PM Replicating 'E:\Project\Testing\bdb\v50\conf\rpsSend.xml.9' (929) 

104 08:11:38 PM Replicating 
'E:\Project\Testing\bdb\v50\webapps\bdb\download\obm-linux.tar.gz' (38.5M) 

105 08:12:29 PM Replicating 
'E:\Project\Testing\bdb\v50\webapps\bdb\download\obm-mac.zip' (12M) 

106 08:12:45 PM Replicating 
'E:\Project\Testing\bdb\v50\webapps\bdb\download\obm-netware.zip' (6.7M) 

107 08:12:54 PM Replicating 
'E:\Project\Testing\bdb\v50\webapps\bdb\download\obm-solaris.tar.gz' (6.6M) 

108 08:13:02 PM Replicating 
'E:\Project\Testing\bdb\v50\webapps\bdb\download\obm-win.exe' (39.5M) 

109 08:13:56 PM [End] Refreshing File 

 
Total throughput of 837 MB/hour and 2.63 GB/hour for 2M/2M DSL and 100MBit LAN 
Ethernet respectively can be reached. If you are not getting close to this speed with similar 
network and machine setup, please check your I/O, network subsystem, or CPU usage to see 
if there is a bottleneck. 
 
^Back to top
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2. Common Error Messages 
2.1. "Quota Exceeded"  

This means that the backup account has run out of its allocated quota. Please contact BDB to 
increase your backup quota. 
 
^Back to top

2.2. "Access is denied"  

This means that the file is not accessible by OBM. Please check if the system account that 
runs OBM has read access permission to the mentioned file. 
 
^Back to top

2.3. "Checksum incorrect" / "Uploaded file size incorrect" 

This error occurs when the backup file uploaded to the BDB server is corrupted. Corrupted 
backup files will not be stored on the backup server. However, it will be attempted again 
during the next backup job. 
 
If more than one backup job of the same backup set is being run on more than one computer 
at the same time, you might get this error. Please check if you have installed the client 
software (OBM) with the same backup account on more than one computer. 
 
Also, please check the file C:\Program Files\OBM\home.txt and see if you have more than 
one “.obm” record in the file C:\Documents and Settings\Administrator\.obm that refers to 
the same backup account on the BDB server. If you can find such entries, simply remove the 
redundant lines from this file and restart the computer. 
 
Sometimes this problem can be caused by network instability. If this only happens 
occasionally, you can safely ignore this error. 
 
^Back to top

2.4. "File 'obm-delta.tmp' does not exist on server" / "File 
'obm-chksum.tmp' does not exist on server" 

For OBM v5.0.1.4 or before, please: 

1. Upgrade your OBM to a newer version. 

2. Delete the obm-delta.tmp or/and obm-chksum.tmp files from your “temporary 
backup directory”, (e.g. C:\Backup\MSExchange\1137065709669).  

 
For later versions of OBM, you can simply do step 2 to remove the problematic files which 
were left behind during the backup operations of previous versions. 
 
^Back to top

2.5. "C:\xxx\yyy\zzz.txt has been removed already"  

There is latency between the backup agent with the list of files to be backed up and the time 
these files are actually backed up. If any of these files are removed between this latency, an 
informative message, “C:\xxx\yyy\zzz.txt has been removed already”, will be logged in the 
backup log report. Under most conditions, you don’t need to worry about this since files 
created and then removed in this situation are usually temporary files. It is used by some 
other applications and it is not necessary to back up these files. 
 
If you are using In-File Delta, please make sure the “Temporary directory for storing backup 
files” setting of your OBM is pointing to a writable directory with plenty of disk space. 
 
^Back to top
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2.6. "The process cannot access the file because another process has 
locked a portion of the file"  

You get this message when backing up “C:\xxx\yyy\zzz.txt” because another application has 
made a read-exclusive lock on “C:\xxx\yyy\zzz.txt”. The backup agent, therefore, is unable 
to open the file to read its content. Please try the following to resolve this problem: 

 Enable the Volume Shadow Copy option for the corresponding backup set if you are 
on Windows 2003 or XP.  

 If you are on an older version of Windows, you may need to obtain a generic “Open 
File Manager”, like St. Bernard Open File Manager - http://www.stbernard.com/), in 
order to back up the locked file(s). 

 If the locked file is a database file held open by one of our supported applications 
(e.g. Microsoft SQL Server, Microsoft Exchange Server, Oracle, Lotus Domino/Notes, 
MySQL), simply use the corresponding add-on module to back up the database. 

 If the locked file is not important (e.g. C:\pagefile.sys), simply exclude the locked file 
from your backup source. By doing so, this message will not appear again. 

 If the locked file is a file held open by some other third party applications, you can use 
the [Pre/Post Command Line Tool] to shutdown/restart the application that is locking 
the file before/after a backup job to make sure that no locks are on files during 
backup.  

 
^Back to top

2.7. "The process cannot access the file because it is being used by 
another process"  

This means that the file is currently locked by another process (or program). Please shut 
down the program locking this file before running the online backup program again. You can 
also refer to “What do I have to do in order to back up open files” for more information (for 
the file backup set type only). 
 
^Back to top

2.8. "Premature end of input"  

It means that the client software has a problem downloading the list of files to be backed up 
from the backup server. It will retry getting the list again. This is nothing to worry about. OBM 
logs this as information rather than as a warning. 
 
^Back to top

2.9. "Invalid XML Character" / "XML document structures must start 
and end within the same entity" 

Please try the following: 

1. Log on to the web interface of this backup account (vs. use OBM) 

2. Go to the [File Explorer] page and browse to the directory reported that contains this 
problem 

3. Check if there are any file names containing strange characters; if there are, delete 
them 

4. Try backup again 

 
If this does not work, contact BDB staff to have them try increasing the "connectionTimeout" 
attribute within the "Connector" tag inside [BDB Home]\conf\server.xml to a larger value 
(e.g. connectionTimeout="180000" or connectionTimeout="600000"). This should help 
solve the problem. 
 
^Back to top

 

http://www.stbernard.com/
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2.10. "Incorrect Function"  

Please check if you have any antivirus or personal firewall software installed. Disable it from 
scanning the related data and traffic and note if the problem persists. 
 
^Back to top

2.11. "HTTP/1.1 502 Proxy Error"  

The specified Secure Sockets Layer (SSL) port is not allowed. ISA Server is not configured to 
allow SSL requests from this port. Most Web browsers use port 443 for SSL requests. 
Refer to http://support.microsoft.com/kb/283284  
 
^Back to top

2.12. " [Microsoft][ODBC SQL Server Driver][SQL Server]The statement 
BACKUP LOG is not allowed while the recovery model is SIMPLE" 

You need to change the Recovery model to FULL. If you are using Microsoft SQL Server 
7.0/2000, please refer to the following screenshots: 

1. http://MyBox.BackupDepositBox.com/download/SQL7-TuncateLogOnCheckpoint.jp
g  

2. http://MyBox.BackupDepositBox.com/download/SQL2000-FullModel.jpg  

 

If you are using MSDE, please issue the following command: 

osql -E -S [Server Name] -Q "ALTER DATABASE [Database Name] SET RECOVERY FULL" 
 
These will enable the transaction logging option for your MSDE databases and allow 
incremental/differential backup to be run with no problems. 
 
^Back to top

2.13. "CExBackup::backupService:HrESEBackupSetup: Error Number 
0xc800020e: An incremental backup cannot be performed when 
circular logging is enabled" 

You need to disable circular logging in MS Exchange. Please uncheck the [Enable circular 
logging] option as shown below and restart the “Microsoft Exchange Information Store” 
service after you are done. 

 

http://support.microsoft.com/kb/283284
http://mybox.backupdepositbox.com/download/SQL7-TuncateLogOnCheckpoint.jpg
http://mybox.backupdepositbox.com/download/SQL7-TuncateLogOnCheckpoint.jpg
http://mybox.backupdepositbox.com/download/SQL2000-FullModel.jpg
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^Back to top

2.14. "CExBackup::backupStorageGroup:HrESEBackupTruncateLogs: 
Error Number 0xc7ff1004: (null) " 

This is an error returned by the Microsoft API and is a Microsoft issue. Please try to restart the 
"Microsoft Exchange Information Store” service. If the problem persists, you may want to 
schedule the service to restart on a daily basis. 
 
^Back to top

2.15. "CExBackup::backupStorageGroupLog:HrESEBackupGetLogAnd
PatchFiles: Error Number 0xc8000232: Some log or patch files are 
missing" 

If you have just disabled the MS Exchange circular logging option, please try running a full 
backup again. This should fix the problem. 
 
^Back to top

2.16. "CExBackup::backupFile:WriteFile: Error Number 0x6: The handle 
is invalid"  

This is MS Exchange having a problem in writing to the Temporary spooling directory. Please 
ensure that the system account running MS Exchange has the Full access right to that 
directory. If it is a network drive, please use a UNC path (e.g. \\server\share), and make sure 
that “Network Resources Authentication for Windows” is properly set for the corresponding 
backup set. 
 
^Back to top

2.17. "Path ‘C:\Temp\MSSQLServer\1137040769567’ does not exist" 

If you get this error while you are doing MS SQL or MS Exchange backup, please try to use a 
UNC path (e.g. //server/share) in "Temporary directory for storing backup files" under 
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[Backup Source Settings]. Please make sure that your OBM is on the same machine as MS 
SQL or MS Exchange. Please also ensure that you have included the appropriate “Network 
Resources Authentication for Windows” information in the backup set. 
 
For MS SQL Server, you may want to check whether it can spool the database file correctly by 
running the following command: 
 
(Windows Authentication mode) 
osql -E -Q "DECLARE @dbname char(64) SET @dbname = 'xxx' BACKUP DATABASE 
@dbname TO DISK = '//server/share/abc.txt' WITH SKIP" 
 

OR 
 
(SQL Server Authentication mode) 
osql -U USERNAME -P PASSWORD -Q "DECLARE @dbname char(64) SET @dbname = 'xxx' 
BACKUP DATABASE @dbname TO DISK = '//server/share/abc.txt' WITH SKIP" 
 
Note:  

USERNAME/PASSWORD = the database username/password 
xxx = the database that you would like to back up 
//server/share/abc.txt = the location for the database spooling file 
 
^Back to top
 

2.18. "Expect log sequence 'xxx' but found 'SERVERNAME\Microsoft 
Information Store\First Storage Group\E000xxx.log'" 

This occurs when the log sequence of MS Exchange was altered by other backup software, 
e.g. NTBackup. When the Backup Manager next performs a MS Exchange backup, the 
Exchange log sequence may not match the one that it is expecting. With the broken 
sequence, the Exchange server cannot be restored to its latest state.  
 
To resolve this problem, you need to deactivate all other backup software that is operating on 
MS Exchange, and then you need to perform a Full MS Exchange database backup manually 
via the Backup Manager. 
 
Alternatively, instead of backing up transaction logs during the weekdays, you can consider 
doing Full Exchange Database backup on a daily basis with the In-File Delta option enabled. 
This should avoid interference from other backup software while keeping the amount of 
upload data to a minimum. 
  
^Back to top

2.19. "The last backup jobs of *.stm (2006-10-30-13-40-21) and *.edb 
(2006-11-04-03-05-00) don’t match for database 'ServerX\Microsoft 
Information Store\First Storage Group\Mailbox Store (ServerX)'" 

For MS Exchange backup, *.stm and *.edb are backed up in pairs. If this error occurs, it 
implies that during a previous backup, there was a problem with either the *.stm or *.edb 
file. If this happens, please perform a Full MS Exchange backup manually via the Backup 
Manger to resolve this problem. 
  
^Back to top

2.20. "No *.stm found for database 'ServerX\Microsoft Information 
Store\First Storage Group\Mailbox Store (ServerX)'" 

This suggests that the .stm file on your server may have been corrupted or found missing. To 
resolve this error, please perform a Full MS Exchange backup manually via OBM. 
  
^Back to top
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2.21. Exception in thread "main" java.lang.UnsatisfiedLinkError: 
/usr/local/obm/jvm/lib/i386/libawt.so: libXp.so.6: cannot open 
shared object file: No such file or directory… 

This is caused by a missing library in Fedora Core 6. To resolve this, just open a terminal window. 
From here type in the command 'yum install libXp' (please note that the command is case sensitive), this 
will ask you if it is OK to download the package. Just type 'Y' and the libXp library will be installed. Once 
installed, just run the command  
 
"sh $OBM_HOME/bin/RunBackupManager.sh"  
 
You should find that the OBM will open up and you should be able to create the backup set via the GUI 
interface.  
 
When running the 'yun install' command, you may see the following error:  
 
Loading "installonlyn" plugin  
Existing lock /var/run/yum.pid: another copy is running. Aborting.  
 
This is because the background YUM updater service is running. To stop it, run:  
 
/etc/init.d/yum-updatesd stop  
 
Once the process has been stopped, you should be able to run the command 'yum install libXp' without any 
problems. When done, restart the background updater service. 
  
^Back to top
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